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Steps for the Doctor being appraised 
5 key steps need to be carried out in order to complete Appraisal 

Get started - Activate your account and log on to the system 

 

Validate your personal details in the profile section 

 

Add your supporting information into your portfolio 

 

Complete a self assessment three weeks before your appraisal date and update 
any information if necessary 

 

Carry out your appraisal meeting with your appraiser and sign-off the process 
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Getting Started 
Activating your account 
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You will receive two welcome emails from 
lucy@equiniti-ics.com – One with a username and 
password and another with your activation code.  
Click on the link in your email which will open the 
Sign In page. 

 
 
 
 
 
 
 
 
 
 
 
 
We suggest you copy and paste the complex 
password into the password field.   

1 
 
Once you have logged into the site you will be 
given the opportunity to change your password 
and create a security question. 
 
 
 
Please do read the terms and conditions. 
There are some very important pieces of 
information within them – including that it is 
your responsibility to ensure that no patient 
identifiable information is uploaded to the 
system. 
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Getting Started 
Home Screen 

7 

 
When logging into your account you will be directed to the RMS home screen. Information from your Trust 
will be fed into the Announcement section. You will also be able to track your progress using the central 
panel. 
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Validating Your Details 
Check the pre-populated information 
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Click the tab at the top of the page entitled Profile 
> Edit Profile 
 
Work your way through the chevrons by clicking 
the next button at the bottom of the screen once 
you have updated the required fields. 

 

1 
 
It will not allow you to proceed if you leave 
required fields blank (e.g. DoB) so please ensure 
you have filled in information for all fields with 
an asterisk (*) next to them. 2 
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Validating Your Details 
Selecting a nominee 
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You can nominate someone to access your 
account and upload documents for you.  The 
nominee will not have access rights to any of your 
appraisal outputs. 
 
In order to select a nominee click on the address 
book Icon next to the nominee box. 
 

1 

A pop up window will appear. Input the 
nominee’s name and search for them.   
 
If they are not already on the system, click on the 
Add Nominee button and provide their details. 
Your nominee will then be sent log in emails. 
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Validating Your Details 
Appraisal Lead 

In order to link with your appraisal lead click on the                     
address book icon         next to Appraisal Lead 

Complete your 
portfolio 

Self assessment 
Appraisal and 

sign-off 
Validate 
details 

Getting Started 

Click the search box, choose your 
appraisal lead and click OK 

1 2 
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Validating Your Details 
Declaring scope of work 
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Add a description of the nature of the work you 
carry out at your primary place of work into the 
free text box. 
 
Attach your job plans and add time PAs into the 
provided fields if applicable. 

 

1 If you wish to add other places of work, click on 
Add New Record underneath the ‘Other Places of 
Work’ title. 
 
Once you have clicked on Add New Record a pop 
up window will appear.  Enter the required 
information into the provided free text boxes. 
 
 
 
 
 
 
 
 
 
 
 
The GMC has stated that you need to declare all 
places of work - Specifically, anywhere which 
requires a licence to practice medicine.  This may 
include locum work, private work and/or charity 
work. 
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Validating Your Details 
Selecting appraisal information 
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You will need to enter your correct appraisal date 
in order to proceed with the process – This can be 
changed later on.  In order to select a date, click 
on the calendar icon         and select a date from 
the pop up calendar. 
 
Enter your Revalidation Date as provided by the 
GMC. 
 
 
If you know your Appraiser at this point you can 
select them by clicking on the address book icon.              
 
 

If you are an academic and would like more 
than one Appraiser present at your 
appraisal, you have the option to include  
additional appraisers at the bottom of the 
screen, to record who was present. 
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Validating Your Details 
Selecting your appraiser 

 
Find your appraiser by typing their 
name/GMC number or email into the 
box and click search. Find the name 
you need and click OK 

 
 
 

1 2 
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…If they don’t appear then click 
Add Appraiser and complete the 
fields. 



Completing Your Portfolio  
Uploading supporting information 
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Click the Portfolio tab at the top of the page once 
you are ready to begin uploading supporting 
evidence. 

1 2 
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 Click the green Upload Supporting Information 
button. 

 
 Guidance for including mandatory GMC supporting 
information. 



Completing Your Portfolio 
Uploading supporting information 
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Choose your type of Supporting Information 
from the drop down list and name your 
document.  
 
 
Click the Attach Document button which will 
open a screen allowing you to browse all the 
documents on the computer/device you are 
using. 
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Please note:-  
Attached documents need to meet certain 
naming criteria. You may find it easier to re-
save the document without any 
punctuation before uploading. 
 
You do not have to upload a document on 
each occasion, you may wish just to reflect 
on  you practise in the notes field. 



Completing Your Portfolio 
Uploading supporting information 

16 

5 
 
 
Uploaded documents will automatically be 
saved as ‘Published’. Documents marked as 
published will be made available to your 
appraiser upon submission of your portfolio. 
Should you not wish to submit a document 
and keep it for your own records you can 
change the status to ‘Draft’. 
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You will need to specify a retention period for 
documents that you want to remain in your 
portfolio beyond this appraisal.  To do this click on 
the calendar symbol and select the date you wish 
to keep the document until from the pop up 
calendar window.  Alternatively you can select ‘to 
be used for the next appraisal only’. 
 
Please see next page for Review GMP Mapping 

 
 



Completing Your Portfolio 
Assigning attributes to supporting information 

17 

 
All documents and reflective notes should be 
linked to attributes of Good Medical Practice. For 
the 6 GMC mandatory documents the system will 
automatically link supporting information to 
suggested attributes (These can be amended as 
appropriate), however for all other mandatory 
documents this mapping will need adding by the 
doctor. 

1 2 
 
Once you have chosen the appropriate GMP 
domains and attributes, click the green File 
button at the bottom right hand corner of the 
screen 
 
 
If you are an Educational supervisor you may 
wish to file the same document in your 
Educational Supervisor’s portfolio.   You can 
do this by selecting the relevant folders in the 
left hand box and adding the ticks where 
relevant 
 
The automated selection of domains and 
attributes were selected by all the Medical 
Royal Colleges. 
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Complete your 
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Completing Your Portfolio 
Uploading multiple documents 
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If you wish to upload more than one document at 
a time, click on the green Upload Supporting 
Information button on the Portfolio screen as 
before. 

 

1 2 
 
Click on the Upload Multiple Documents button 
on the top right hand corner of the next screen. 
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Completing Your Portfolio 
Uploading multiple documents 
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Click on the Attach Document button.  This will 
bring up a pop up window allowing you to browse 
all documents on your computer/device.  Select 
the documents you wish to upload. 

 

3 4 
 
Select the type of supporting information you are 
uploading from the drop down menu. 
 
Once happy with the selection of documents, click 
on the Upload all documents button 

 
 
 
 
 
 
 
 
The automated selection of domains and 
attributes were selected by all the Medical 
Royal Colleges. 
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Completing Your Portfolio 
Bulk change SI status 

Validate details Self assessment 
Appraisal and 

sign-off 
Complete your 

portfolio 
Getting Started 

You can change mass documents from 

draft to published or vice versa.. Click Bulk 

Change SI Status and a new window will 

appear. 

1 Choose current status, select 

documents, new status then click OK. 

That will change them all in one go 

2 
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Completing Your Portfolio 
Exporting your portfolio 

Validate details Self assessment 
Appraisal and 

sign-off 
Complete your 

portfolio 
Getting Started 

You can export your entire portfolio to have 

your own back up of the documents. 

Click Export Portfolio 

A separate window will open asking you 

what you want to export and is it for 

printing or storage. Make your choices 

and click OK 

1 2 
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Completing Your Portfolio 
Location of export file 

Validate details Self assessment 
Appraisal and 

sign-off 
Complete your 

portfolio 
Getting Started 

Your export file will be stored in My Account-My Exports. 

You can then download the file to your own PC or hard 

drive 

1 
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Completing Your Portfolio 
Health and probity declaration  
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The health and probity declaration are carried out 
electronically.  Click on Portfolio > Health 
Declaration or Portfolio > Probity Declaration for 
the health and probity declarations respectively. 

 
 
 
 
 
 
 

1 2 
 
Once you have made your self declaration, click 
the Add to Portfolio button at the bottom right 
hand corner of the screen.  Your health and 
probity declarations will then automatically 
appear in your portfolio in the relevant sections. 
 
The declarations should be made as close to the 
appraisal date as possible. 
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Self Assessment 
Completing your self assessment  

24 

 
 
 
3 weeks before your appraisal date you will 
receive a reminder to check your details are 
up-to-date and complete a self-assessment; 
this will come from lucy@equiniti-ics.com.  To 
do this click the Appraisal tab at the top of the 
screen. 
 
Check your appraisal date and appraiser details 
are correct and make any changes as 
necessary. 
 
 
Begin the self assessment by clicking the green 
Start Self Assessment button at the bottom of 
the screen. This will open the self assessment 
screen. 
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...Self Assessment cont. 
Completing your self assessment  

Validate details 
Complete your 

portfolio 
Appraisal and 

sign-off 
Self assessment Getting Started 

Once the Self Assessment screen appears 
complete the 3 declarations at the top and  then 
rate yourself from poor to excellent against each 
statement. Once completed your Appraiser will 
then be able to view your supporting information 
along with the completed self-assessment. 
 
Click View Reflective Notes Summary to review a 
summary of all your reflective notes according to 
document type (Optional). 
 
To Complete and send portfolio to your appraiser 
click `submit’ 
 
 
All uploaded information will be accessible from 
the self assessment page. If you click on one of the 
titles on the left hand side of the screen, the 
supporting information will appear in the box on 
the right hand side.  
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 Appraisal 
The appraisal process will be facilitated by your appraiser 

 

 

Appraiser starts appraisal meeting from their RMS  account 1 

26 
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Appraiser Statements   
Agree to the outcomes of your appraisal 

27 

 
After the appraisal meeting your appraiser will 
make statements based on your discussion and 
the supporting information provided; you will be 
able to see these statements once you login to 
your account after the appraisal. 

 
 
You will then need to declare that you are in 
agreement with the PDP and confirm your 
responsibility for the information provided by 
completing the Appraisee Statements before you 
leave your own feedback. 

 

1 

Validate details 
Complete your 

portfolio 
Self assessment 

Appraisal and 
sign-off 

Getting Started 

2 



Appraisal Feedback and Sign-Off 
 

If you are happy with the appraisal and 
have left your feedback, click Submit 
Appraisal to finalise. 

1 

2 

You will be asked to leave feedback for 
your appraiser by rating their skills and 
providing any relevant comments. 

3 
If you have any concerns about your 
appraisal you can click the red 
Concerns – Refer to RO button.  This 
will halt the process and direct your 
concerns to your RO. 
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        Closing Your Revalidation Cycle 

To close your Revalidation Cycle click 
Revalidation (in red) then edit. 
 
 
Click on Revalidated then enter the 
date of Revalidation. 
 
 
Ensure you have completed the 
Estimated Next Revalidation Date. 
Then click OK at the bottom of the 
screen. 
 
This will ensure your current cycle is 
closed and your new cycle is opened. 
 
 
Please ensure your profile is complete 
and your cycle start date has been 
entered. 

3 
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Completing Your Portfolio 
Uploading previous paper appraisals 

30 

If you would like to upload a previous appraisal, 
not carried out on this system, you can do so by 
entering the appraisal history page Appraisal > 
Appraisal History, clicking ‘Add New Record’ 
underneath ‘Previous Appraisals’ and adding the 
required information 

 
 
 
 
 
 

1 2 Once you have added the Appraisal details, select 
the newly created appraisal record from the list of 
previous appraisals 
 
In the ‘Appraisal Output Documents’ table  select 
‘Add New Record’ and upload any previous 
appraisal documents you wish to include. 
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          Take Caution – Situations that could impact the completion of appraisal 

 

          Note – Notes, usage tips or additional information 

 

          Refer to – The instruction number indicated 
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Steps for the Appraiser 
4 key steps need to be carried out in order to complete the appraisal process 

Get started - Activate your account and log on to the system 

 

View the Appraisee’s RMS account and ensure all the necessary documents 
have been submitted 

 

Prepare for the appraisal meeting by reading all documentation 

 

Carry out the appraisal meeting with your Appraisee and agree the outcomes of 
the appraisal 

33 
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Getting Started 
Activating your account 

34 

 
You will receive two welcome emails from 
lucy@equiniti-ics.com – One with a username and 
password and another with your activation code.  
Click on the link in your email which will open the 
Sign In page. 

 
 
 
 
 
 
 
 
 
 
 
We suggest you copy and paste the complex 
password into the password field.  

1 
 
Once you have logged into the site you will be 
given the opportunity to change your password 
and select a security question. 

 
 
 
Please do read the terms and conditions. 
There are some very important pieces of 
information within them – including, it is your 
responsibility to ensure no patient identifiable 
information is uploaded to the system. 
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Getting Started 
Home Screen 

35 

 
Once you have logged into your account you will gain access to the RMS home screen.  All information from 
your Trust, RST and GMC will be fed into the Announcement and News sections.  The Appraiser will have a 
new tab called ‘My Doctors’. 

1 
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Getting Started 
Access your Appraisee’s accounts 

36 

 
When you are ready to assess your doctor’s  
portfolio click on the My Doctors tab.  This 
will open a page listing all of the doctors 
linked to your account. 
 
 

1 
 
To view the Doctor’s supporting 
information click the blue View Appraisal 
link. This will open a new window. 
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Check Documents 
Access the Appraisee’s supporting information 

37 

 
Agree with the statement that you are a 
revalidation ready appraiser trained 
 
 
Double-click on the document icon against any 
of the documents you wish to view, or use the 
View link to see reflections. 
 
 
Click the View Reflective Notes Summary button 
to review a summary of the doctor’s reflective 
notes, by category. 
 
If you are happy with the Appraisal to go ahead 
click on either A or B.  If you have concerns, or 
wish for alterations to be made to the Portfolio, 
select C or D and leave a comment explaining 
your decision. Click the green Submit button 
once ready. 
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Prepare for Meeting 
Read through all the supporting information 
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Once you have confirmed you are happy for the 
appraisal to go ahead you can still access the 
Appraisee’s supporting evidence by clicking 
Portfolio > Portfolio 

 
 

1 
 
You can then read through all the supporting 
documentation by double-clicking the 
document icon, or read any reflective notes by 
using the view link to the right. 
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Appraisal and Sign-Off 
Constructing the PDP and summary of appraisal discussion 

39 

 
When you click on the top Appraisal tab you 
will be asked to confirm the details of the 
appraisal – The date of Appraisal and 
Appraiser details 
 
 

1 
 
On the day of the Appraisal you can begin 
the Appraisal process by clicking the 
green Start Appraisal button. 
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Appraisal and Sign-Off 
Constructing the PDP and summary of appraisal discussion 
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Tick all boxes as you go to confirm you have 
discussed each point.  
 
To add a development need or objective to the PDP 
click the PDP link . 
 
To add a summary of your discussion click the 
Discussion link. 

 
 
 

1 
 
If you wish to view any supporting 
information it will all be accessible from this 
page.  Click on a title on the left hand side of 
the screen, and the relevant documents will 
appear on the right hand side. 
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Once you click Discussion you can leave your 
notes and they will add to the discussion part 
of the PDP page  

 

Appraisal and Sign-Off cont.… 
Constructing the PDP and summary of appraisal discussion 

41 

 
Once you click the Add PDP link a window will 
appear allowing you to enter details regarding the 
development need. Enter the required information 
into the free text boxes. This will then populate the 
PDP document. 
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Appraisal and Sign-Off Cont.…. 
Confirm the PDP and summary of discussion 

42 

 
Once you have constructed the PDP and added any 
notes on the appraisal discussion, you can then 
confirm you are happy with the outcomes and 
submit the development plan by clicking the green 
Confirm PDP button.  When you click confirm PDP, 
you will be unable to update or edit any documents. 

 
 

1 
 
There is a red Concerns – Refer to RO button 
throughout the system if you have any issues.  
This will stop the process and allow you to 
discuss any issues with your RO. 
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Appraisal and Sign-Off Cont.…. 
Sign-off statements 
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To complete the Appraisal process complete 
the 2 declarations at the top in green.  
 
Complete the 3 statements rating the 
Appraisee. 

 
 

1 
 
Enter comments in the free text box at the 
bottom of the page 
 
Submit the Appraisal by clicking the green 
Submit Appraisal button. 
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I can’t access my Appraisee’s information. 
When I click View Appraisal nothing 
happens. 
 
This may be because you have blocked pop 
ups on your internet browser – If this is the 
case, once you allow pop ups you will be 
able to access your Appraisee’s account 
with ease. 
 
 
I’ve forgotten my password – What now? 
 
On the login page there will be a forgot 
password link.  Please follow the 
instructions. Please note if you enter the 
incorrect password 3 times in a row, it will 
lock you out of the system. 

 
I can’t find my Appraiser 
 
Firstly, please ensure you click on the 
address book and search for your Appraiser, 
rather than type your Appraiser’s name into 
the free text box. 
 
When the popup window appears only fill 
in one search field (perhaps the surname 
only) rather than fill in every search field. 
 
If you are still unable to locate your 
Appraiser give us a call and we will check if 
their details have been added to the system 
 
 

Common Questions 
Let us help you resolve any issues 
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I’ve moved Trusts and my new Trust is 
using a different piece of software for 
appraisals and revalidation.  Will I have to 
upload all my supporting information 
again into the new system? 
 
Yes - you will have to re-upload all your 
information into the system used at your 
new Trust.  However, we have tried to make 
this transition easier for you by including an 
Export Portfolio button which can be 
located in your Portfolio screen. 
 
When you click on the Export Portfolio 
button a pop up screen will appear allowing 
you to select which files you would like to 
export. 
 
You may also wish to export your portfolio 
for personal back-up reasons also. 
 

Common Questions 
Let us help you resolve any issues 
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My scanner has produced a large PDF 
document with all my scanned supporting 
information.  How can I split this PDF 
document into different parts so I can 
upload my different supporting 
information separately?  
 
You can split a pdf document by clicking on 
Edit > Take a Snapshot. This will then allow 
you to select the area you wish to separate 
from the document. 
 
After selecting the area, you can then right 
click and select Copy Selected Graphic. 
 
Open up Microsoft Paint and paste the 
selected area.  Then click on File > Save and 
save the selected area as a separate file. 
 
Please note this method can also be used 
to split MAG forms 
 

Common Questions 
Let us help you resolve any issues 
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It’s taking a particularly long time to 
upload documents, is there anything I can 
do to reduce this upload time? 
 
Like all other software, the larger the file, 
the longer it will take to upload the 
document.  A useful trick is to save the large 
document as a smaller file type using the 
method described below. We recommend 
that you try to upload files smaller than 
1MB and no bigger than 10MB 
 
Click on File > Save As this will cause a pop 
up window to appear.  Choose an 
appropriate File name.  In the Save as type 
field choose from the drop down menu 
‘smaller’ file type. 
 
Example of small file types 
pdf 
.doc and docx 
.jpg 

Common Questions 
Let us help you resolve any issues  

Example of large file types 
PNG 
BMP 
TIF 
GIF 
.ppt and .pptx (Powerpoint presentations) 
 
We suggest you re-save scanned documents 
to a pdf format 
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I’ve forgotten to include a PDP in the 
appraisal and have now completed the 
appraisal process.  Is there any way this 
can be rectified? 
 
Unfortunately once you have submitted 
your appraisal you have effectively locked 
down your outputs from the meeting. 
 
However you can write up your PDP in a 
word documents and store it with your 
previous appraisal outputs on the system. 
 
Click the Appraisal tab at the top of the 
page and Appraisal History underneath it.  
Under the table entitled ‘Appraisal Output 
Documents’, click on Add New Record. 
 
A pop up window will then appear allowing 
you to attach a file. 
 
 

Common Questions 
Let us help you resolve any issues 
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I’ve completed my appraisal successfully 
but I can no longer see my supporting 
information in my portfolio.  Why is this? 
 
Please be reassured that no information is 
lost.  After an appraisal is completed the 
system archives any Supporting Information 
that is no longer valid for your next 
appraisal.  This is governed by the expiry 
date/retention period given to each piece 
of supporting information.  The system will 
put a default retention period of after your 
next appraisal. 
 
If you wish to retrieve an archived piece of 
information, please use the search tools 
and resave (renaming the document) back 
into your portfolio. Click on the Portfolio 
tab at the top of the screen, Search 
Supporting Information and then enter 
your search criteria in the field provided. 
 
 
 

Common Questions 
Let us help you resolve any issues 

 
Alternatively go to Appraisal > Appraisal 
History and the  View Portfolio link where a 
snapshot of your portfolio at the time of 
your appraisal exists for those appraisals 
which took place after 5th of December 
2012. 
 
 
 
Searching Supporting information 
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I am an Appraiser and I cannot view my 
Appraisee’s information.  Why is this? 
 
This may be because your Appraisee has 
not changed their information from draft to 
published.  In which case you can send the 
Portfolio back by clicking option D within 
the Portfolio Assessment page ‘The doctor 
has provided inadequate or insufficient or 
too much supporting information for an 
assessment to be made.​’ and asking the 
Appraisee to Publish all their documents 
before re-sending their portfolio. 
 
It may also be that you are selecting to view 
the reflective notes rather than clicking on 
the icon to view the document.  You must 
click on the document icon if you wish to 
open the file.  The view link will open the 
reflective notes (Please see page 28 for 
details). 

Common Questions 
Let us help you resolve any issues 

 
Sending Supporting Information back to the 
Appraisee 
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We have an experienced Helpdesk 
Let us help you resolve any issues 

If you are in need of further assistance or have any 
questions, please contact us using the below methods: 

 
 Phone:  0845 180 1405 
 
 Email:  info@equiniti360clinical.com 
 

Our helpdesk is open from Monday - Friday, 8am - 8pm 

mailto:info@equniti360clinical.com

